
Latest October  2023 – Updates/Upgrades to 
Vespa/Vespa2 MSE Design  

Software. Item 1. Design Methodology  
 

Vespa now includes AASHTO 2010 LRFD and AASHTO 2015 LRFD Design Methodologies.  (Jan 2016) 

1.1 AASHTO 2010 LRFD ‐ Update/Upgrades:   

1.1.1 Static Analysis:  

1.1.1.1 Live/Dead Loads  

The original version of AASHTO 2010 LRFD included with Vespa treated Live Loads as an “equivalent 
height of soil” in accordance with 11.10.10.2 (i.e. 600mm of soil depth).   

In an effort to model loads more explicitly, this method was replaced with the ability to set the actual 
surcharge load (kN/sq.m or lbf/sq.ft), load type (Live/Dead), and offset from the face of the Wall.  

 

  

When loading older Vespa files, the equivalent Live Load will be automatically calculated based on the 
previous input equivalent soil height.  The other result of this change is the load factor applied to the 
Live Load. Modelled as a soil surcharge (previous version), a Load Factor of 1.5 (ES)was applied.  When 
modelled as an actual Live Load Surcharge (current version), a Load Factor 1.75 is applied.    

1.1.1.2 Block/Grid Connection Factors  

Previously, Reduction Factors for Creep (RFcr) and Durability (RFd) at the Block/Grid Connection were 
defaulted to be those provided by the Geogrid manufacturer for Creep and Durability of the Geogrid 
Reinforcement. These were editable, however, if they were changed, they would alter the Geogrid 
Reinforcement properties as well as the Connection Properties.  New fields have been provided to 
separate these Reduction Factors for a) Reinforcement and b) Connection.    



 

  

 

1.1.1.3 Seismic  

Previous AASHTO 2010 did not include Live Load in the Seismic analysis.  It is now included with the 0.5 
combined Load Factor.  

1.2 AASHTO 2015‐LRFD  

1.2.1 Static Analysis  

1.2.1.1 Tmax Calculation  

Per Figure 11.10.6.2.1.2, for calculating the Vertical Pressure on reinforcements in sloping situations, the 
extent of the triangular weight above the reinforced zone is limited to 0.7H as shown.  This was 
previously (2010) modeled as the full depth of reinforcement (L).  The 0.7H limitation is more 
conservative but better reflects the actual vertical stress applied to the reinforcement.    

  

 

1.2.1.2Pullout Resistance  



2015 provides a more detailed explanation of the calculation of Vertical Confining Pressure and Zp depth 
in the anchorage zone beneath sloping backfill.  Refer to Figure 11.10.6.3.2‐1.    

 

 

1.2.1.32 Crest Toppling  

Previously (2010), as the option was not provided to offset Live Loads from the back of the Wall, the 
Crest Toppling Calculation always included the Live Load surcharge. 

With the provision for Live Load and Dead Load offsets, the Crest Toppling calculation now checks if the 
Load is outside of the zone of influence, assumed to be 1H:1V from the back of the Coping Unit.   

 

1.2.2 Seismic Analysis  



1.2.2.1 Calculation of Seismic Horizontal Acceleration Coefficient  

Previously, the Seismic Horizontal Acceleration Coefficient, kh, was calculated as a function of the PGA 
and a specified allowable displacement.  In 2015, the displacement criteria has been simplified to either 
allow it, or not, rather than specifying a specific amount of displacement.  If displacement is allowed, the 
Seismic Horizontal Acceleration Coefficient, kh, is reducedto half of As.  Refer to 11.10.7 for full Seismic 
Calculation.    

1.2.2.2 Total Factored Horizontal Thrust (C 11.6.5.1)  

As an additional check for the Total Horizontal Thrust, two potential scenarios are compared. Check 1 is 
100% of Dynamic Horizontal Thrust due to Earth Pressure/Live/Dead Loads with 50% of the Inertial 
Force of the Reinforced Mass.  Check 2 is 50% of the Pae/Paell/Paedl with 100% of the Inertial Force.   

1.2.2.3 –Factored Increment Dynamic Inertia Force at Each Layer of Geogrid.  

For 2015, Internal Stability, the total Inertial Force of the active wedge is evenly distributed to all 
reinforcements by simply dividing the Inertial Force, Pi, by the total number of Layers of Reinforcement.  
This is a change from 2010, where the distribution of the load to the Reinforcements was based on the 
Reinforcements relative contribution to total Anchorage Length.  

1.2.2.4 – Pullout Calculations (Jan 2016 ‐end) 

Previously, the Tmax was recalculated for Pullout in order to remove the Live Loads per 11.10.6.3.2‐1 as 
the Live Load was not considered in the Pullout Resistance.  In discussion with Designers and Vespa 
users, the concern was highlighted that for high walls, the case may occur when a live load (traffic lane) 
could exist in the “active” part of the wall, without necessarily have the same load above the anchorage 
zone. For conservatism, we have there used the same Tmax for Tensile Overstress and Pullout 
calculations.    

1.2.2.5 – Dead Load Default Factors (Jan 2017) 

For Dead Loads, Vespa always used the Default Load Factor value of 1.25 based on Table 3.4.1‐2, where 
DC is described as Component and Attachments.  The assumption here was that Dead Loads would 
typically be a footing for a structure nearby, or even an abutment footing.  It has been suggested by user 
that the default for Dead Loads should be the more conservative ES: Earth Surcharge of 1.5, and let 
people reduce as they see fit, rather than the other way around.  To be conservative, we now have the 
Dead Load default as 1.5. 

Item 2. Project Tab  

2.1 Creation of Project Folder Path  

Previously, when the user entered the Client Name and Project Name, Vespa automatically created a 
File Folder Path using these names in the directory. Vespa users indicated that in most cases, they had 
already created their own Project Folder with related projects documents (CAD files, PDFs, emails, etc), 
so this automated process was not efficient.  This process has been changed as follows:  

•  Prior to “Creating a Wall” the user must select “Set/Change” in the Folder Path to identify the 
Project Folder Path.  Using this method, an existing Project Directory can be selected and set to the 



directory that Vespa uses to send files.  If your Project files are usually found in the same place, you can 
set your starting pointing “Settings / Options / Project File Location”.  By setting your Project File 
location here (Settings), when you are in the Project Tab and select “Set/Change”, it will automatically 
start you in the main directory.  

•  Once the Project Folder Path has been selected, you can now “Create Wall” as before.   

Item 3 – Design Criteria  

3.1 – Load and Resistance Factors (LRFD Methodology).   

The Load and Resistance factors are now being formatted in a table showing the Min. and Max. 
“default” values, as well as the Min. and Max. “Used” values.  Previously, for each load or resistance 
factor, a separate variable was designated for each Min.and Max value. We now have a single variable 
(i.e.LFES – Earth Surcharge Load Factor), with a min. and max. value depending on where itis being used. 
This is more in line with how itis presented in AASHTO(applies to 2010 and 2015, Static and Seismic. ) 
For AASHTO 2010 and 2015 greater flexibility has been added to the Seismic Resistance Factors, 
allowing individual variables for each of the Connection, Pullout, and Tensile (Combined Static/Seismic) 
as well Frictional Resistance Factors for Connection and Pullout (RFconn, RFpull). Note that for RFconn, 
the default value is 1.0, however AASHTO recommends for “frictional” connections this be reduced to 
0.8.  

 

 

 

 

 



 

Item 4 – Wall System  

4.1 – Additional Wall System Characteristics  

Additional fields have been incorporated to allow greater control over quantity calculation, panelization 
of units, etc.  

4.1.1 Pins/Unit – For systems that require pins or connectors, this input will calculate the total quantity 
required for the project.  If the manufacturer has not yet updated this field, it will be editable and the 
user can input a value as required.  

4.1.2 Facia Batter – As a number of different systems have 2 or 3 possible facia batters for the same 
system, we have incorporated the ability to select just a single block, then select the facia batter from a 
drop down menu (if multiple batters exist). This is a change from the previous method where there 
existeda separate block for each wall batter(i.e. Block A ,8 degree, Block A,Vertical, etc).  

4.1.3 Base Course – Some systems include a special base block, or base course, which is used exclusively 
on the first course of the Wall.  This unit can now be defined and used in the panelization, quantity 
estimate, and analysis.    



 

  

Item 5 – Reinforcement Tab  

5.1 – RFcn‐Creep and RFcn‐Durablity  

As discussed above, for AASHTO Design Methodologies, 2 additional inputs have been included to 
separate values for RFcn‐Creep and Durablity. These reduction values relate to the Creep and Durability 
reduction at the Block/Grid connection.  

 



 

5.2 –Generation Increment  

The generation increment is a new feature that allows the Designer to set the Geogrid Length increment 
at which the “Generate”function (Design Tab) steps through a Trial Design. For example, if the 
Generation Increment was set to 1.0ft, the Generate function would step through possible Designs 
starting at the min. base to height ratio (i.e. 6.0ft on a 10.ft high Wall for NCMA), then keep stepping up 
by 1.0ft (7.0ft, 8.0ft, etc), until the Design met all required F.S. or CDR values.  

 Item 6 – Stations Tab  

6.1 Paste Function. As some users create the Wall Stations in Excel or some other spreadsheet, we now 
have the ability to paste cells from a spreadsheet directly into the Stations Table.    



 

Item 7 – Panels Tab  

A new feature has been added to allow the user to align either the Top of Wall or the Bottom of Wall 
better with a set or existing grade.  The “Grade Alignment” feature sets either the Top or Bottom of Wall 
as the starting point for the Generate Routine. For example, if “Top” is selected, the Panelization routine 
begins panelizing the Wall by first matching the top block (or Coping if the “Include Coping in Height” is 
turned on) with the Top of Wall Grade. If your TW grade at Station 1 is set to 100, then the Panelization 
routine would set the Top of Coping to 100 and build the Wall from the Top –Down.  In this case, the 
Top would be the “Set” or “Existing” grade that would have to be adhered to.  Alternatively, if you 
needed to minimize embedment as much as possible, you could set the Grade Alignment from the 

 



“Bottom” and the bottom block would be set to the minimum embedment elevation, then build the 
Wall from the Bottom‐Up.    

As noted above, the normal Panelization routine always starts at the first Station.  However, if there was 
some Datum or grade in the middle of the wall for example that had to be matched (i.e.the TW grade in 
the middle of the Wall has to hit 110ft), you could select the “Datum” toggle and the Drop Down menu 
would give you all of the potential TW grades (based on the input Stations) or BW grades to have the 
Panelization start working from.  

  

Item 8 – Design Tab (April 2017) 

8.1 Grid Group Increment  

Expanding on the current automatic “Generate” functionality, the Grid Group Increment feature runs an 
algorithm that attempts to produce a Trial Design for the entire Wall.  The algorithm takes into 
consideration the fact that Geogrid Reinforcement layers generally should be kept at constant 
elevations (for ease of installation) wherever possible, while still adhering to all Design and Empirical 
limitations (i.e. Max Crest Height, max reinforcement spacing, etc).  Also, the reinforcement lengths 
should be changed at a reasonable interval along the length of theWall.  The Grid Group Increment is 
the value at which the Reinforcement Length changes from one Group of Panels to the other.  For 
example, if the Grid Group Increment is set at 2.0ft, the Reinforcement Length will step in intervals of 
2.0ft from one group of Panels to the next (Note – this is different from the Generation Increment 
described above, which sets the Trial Design Length for an individual Panel). 

 By right clicking on the Elevation portion of the Design Tab and selecting “Select All” or by holding down 
the SHIFT keyand selecting any number of Panels, you can highlight all the Panels you want Designed. 
After you have these panels selected, click the “Apply” toggle in the Grid Group Increment area and then 
input the desired increment that you want the Geogrid to change length along the Wall.  For example, if 
I select all panels, click “Apply”, then input 2.0ft , then hit Generate, the algorithm Designs the entire 
Wall with all layers in horizontal alignment, and the Grid Groups already defined and labelled (Grid 
Lengths in this example are 5.0ft, 7.0ft, 9.0ft, up to 13.0ft at 2.0ft increments.  



  

8.2 No Fines Concrete (April 2017) 

A practice gaining in popularity is the use of a No‐Fines concrete backfill material to create composite 
gravity Walls.  Vespa allows the user to select “Use No Fines” to Generate or define manually a depth of 
Free Draining Concrete behind the Wall.  By selecting “Use No Fines” and hitting “Generate”, the 
algorithm calculates the necessary Wall Depth to resist the standard Conventional Modes of Failure 
(Base Sliding, Overturning, Bearing Capacity).  The user can set the Unit Weight, as this will vary, or the 
Depth if required.    

 



 

 

  

8.3 – Internal Compound Stability (April 2017) 

This tab has been moved outside of the Design Tab to provide more space for results to be shown and 
greater flexibility of input parameters.  

Item 9 – File Menu  

9.1Export to AutoCAD  

The DXF output has been upgraded to be more user friendly to the CAD Designer.  The Facing Units are 
now drawn as individual blocks with a pline, so the user can move them, manipulate them,etc.  Note 
that these Facing Units are just shown as a representation of how they would appear in the Wall and are 
not meant to exactly show the position and location of every unit.  In some cases, corner units and other 
specialized units are used which are not shown and which would change the layout of standard units. 



Also, if a Wall has a lean or batter, this would distort the actual arrangement of the bond pattern (i.e. 
bottom of Wall length is actually longer than top of Wall length).  

9.2 PDF Output  

A number of upgrades have been made to the PDF Report.  The Summary Reports, which summarize 
either the entire Project (Project Materials Summary), or a Single Cross Section (Section Analysis 
Summary) have been expanded to include more detail and better arrange information.   

Section Analysis Summary 

The Section Analysis Summary includes all relevant input and output values for the selected Cross 
Section, which would typically be required by a local Municipal Engineer for review, DOT, etc.  

 Project Materials Summary  

This Summary Report details all quantities for an entire Project and has been formatted to contain 
multiple wall systems, includes pins or connectors as required, all infill, drainage, and core fill quantities, 
as well as reinforcements.  Note that the Total Wall Area noted is the sum‐total of the facing, coping, 
and embedded Wall area.  The Facing area is the total Wall Area minus the Coping Area.  



 

 

Item 10 – Walls Menu  

The Walls Menu has been enhanced to include a more flexible way to “Copy Wall”.  In the previous 
version, beside the “Create Wall” button was an option to “Copy Soil Conditions, Wall System and 
Reinforcement Type” so that when you Create a new Wall in a Project, these variables are already set 
and do not need to be entered in again.  This option always copied the “First” wall in the Project.  Some 
users wanted the ability to Copy the properties from a different Wall in their Project (i.e the fourth Wall, 



for example) when creating the next(fifth) Wall.  Our new “Copy Wall” feature in the Walls menu copies 
the properties from the Current Wall you have selected.    

Additional options have been added to Options/Analysis tab. 

Item 11 – Settings Menu  

 Vespa now allows the user to create various different Facings in addition to standard“Block” (SRW) type 
units.  

Item 12 – Additional Facing Types  

 As the Geogrid Reinforcement arrangement can differ depending on the Facing Type, options have been 
provided to allow the user to detail how the Reinforcement is being configured.  For example, if a Wire 
Mesh type facing is used, the Reinforcement tab changes to provide 4 different options for 
Reinforcement configuration.  

 With the Wire Mesh, the user can opt to use “No wrap”, Face wrap with secondary wrap only, Face 
wrap with primary reinforcement and secondary wrap, and Facewrap with primary wrap only.  The 
associated Primary Wrap, Secondary Top Length, and Secondary bottom length input fields are provided 
as well.   

Note that these are provided for Quantity calculation and detailing only, and are not accounted for in 
the analysis.  The chosen methodology is applied, however, for Facings other than SRW Blocks, 
Facing/Geogrid Connection is not checked.    

 



Item 13 NCMA Design Methodology 

(April 2017) 

A change has been made to the way Vespa handles the vertical component of the Dead Load forces for 
use as a “Resisting Force”. Per Section 7.4.1.2 of the NCMA DMFSRW 3rd Edition, the vertical component 
of the exterior Dead Load is to be neglected as a resisting force if the Dead Load offset is outside of the 
internal influence distance (dint) or the reinforced zone, defined by Lbeta.  In Vespa, As the Dead Load 
was still being applied to the exterior of the Reinforced Mass as a destabilizing force, the vertical 
component of that load was also still included as a stabilizing force (Pqdv).  Although accurate, this was a 
deviation from the NCMA recommendation so the Pqdv has been removed as a stabilizing force if 
outside of the reinforced zone, despite the fact that these vertical forces do exist.  This is a conservative 
change and only applies when the “include vertical forces” is turned on in the Settings/Options.   

Item 14 DXF Updates 

In order to make the DXF output more “print ready” and useful in the field, we have added a few 
upgrades.   

We have added 3 rows under the Wall that show the BOW grade, Min. Applied Bearing Capacity, and 
Reinforcement Requirements for each Panel.  

 

We have also added the Station Data (Station and TOW Grade) to the elevation view so the user can 
reference the original Grades Input. As well, these have been added to another table in the DXF, along 
with the Crest/Toe inputs.   

 



 

 

All of these elements are on independent layers so they can be easily turned off if the user does not 
want them. 

 
Item 15 – Bug Fix (April 2017) 

In the last (April) build, for NCMA Methodology, for the calculation of applied Bearing Load the Dead 
Load was being used in place of the Live Load. Therefore, for very large Dead Loads, the Dead Load 
would be essentially applied twice and results would be conservative for applied bearing load.  This has 
been fixed.   

 

Item 16 – April 2017 

For AASHTO 2010 and 2015, for calculation of Bearing Capacity (Bearing Resistance), we had originally 
adopted the convention of using “L” as the width of the Wall, as opposed to B (which includes the 
facing). The AASHTO direction on this was that either L or B could be used, depending on the thickness 
of the face (i.e. if the face was “thick”, then it should be B).  As this is a vague term and likely relative to 
the MSE type walls, we erred on the conservative side and used “L”, thereby ignoring the facing.  The 
consensus of users is that B is more widely accepted as most block facings are at least 1ft thick or larger 
and there is also a base to consider.  This change has been made.   

 

Item 17 – April 2017 



Previously, in AASHTO 2010 and 2015, the “Overturning” check is a comparison of the calculated base 
eccentricity to the maximum allowable eccentricity. A ratio of e/emax was used to express the fact that 
the emax was not being exceeded.  This check was the only method AASHTO provided for looking at 
overturning.  We have expanded the Overturning check to be more in line with a classic overturning 
analysis, with Mresisting/Moverturning being the actual Overturning check.  We have moved the 
current eccentricity check to the “empirical checks” portion of the analysis, allowing the user to specify 
the max eccentricity in the Design Criteria.   

Item 18 (Bug Fix). (April 2017) 

For AASHTO 2010, the Pae, Paell, and Paedl were being calculated using the full Kae value as they are in 
2015.  In 2010, however, the Static loads are still being applied, so a reduced value for Kae (reduced for 
the static portion) should be used and is now changed.  In short, the previous build overestimated 
applied Seismic loads and was therefore overly conservative. 

Item 19 (May 2017) 

Two items were identified which, when changed, no longer wipe out the existing Design.  Vespa allows 
you to change the Crest Offset and Crest Elevation without causing a repanelization and/or wipe out the 
Geogrid Design that is in there.  The other variable is the Block.  If a Block that has the identical face 
height and width is substituted for the block in the current Design, the Panelization will not occur again.  

Item 20 (May 2017) 

NCMA, Conventional, Seismic, Bearing Capacity 

On page 129 of the NCMA Design Manual, Third Edition, the following equation is given for the Seismic 
Eccentricity, eseismic.   

 

The moment arm shown for the resisting moment is Xw, which is the distance from the toe of the wall 
to the center of gravity.  This is contrary to the Conventional Static version of the same equation, where 
the moment arm is correctly shown as ew, which is the moment arm from the center of the block.  
Vespa followed equation 9‐44 due to this misprint, but has been changed to reflect the ew requirement 
shown in Static.   

 



Item 21 (Bug Fix) (May 2017) 

NCMA, Reinforced 

In the case where a Dead Load was applied to the top of the wall, and the Dead Load Offset was beyond 
the Reinforcement Zone (DLoffset>L), an error in logic was causing the Dead Load to still be included as 
part of the Resistance for some of the calculations.  Specifically, the contributing effect was being 
applied to the Overturning Resistance (which would overestimate the overturning resistance) and the 
applied Bearing Capacity (which would produce a conservative result) in the Static calculations.  It did 
not affect the Base Sliding Calculation, which is typically the critical mode of failure in External Stability 
analysis.  In Seismic, the Dead Load contribution was being applied to Overturning, Sliding, and Bearing 
Capacity.  The error only occurred when the Dead Load Offset was outside of the Reinforced Zone and 
inside of the influence zone (L+H+h).   

Item 22 AASHTO ‐Inclusion of Wall Batter (August 2017) 

AASHTO 2010 and 2015 state that for a Wall Batter less than 10 degrees, the Wall is assumed to be 
vertical.  Based on discussions with Designers, we have concluded that while we can apply this principle 
to the calculation of Ka (and Kae), the model is more accurate if we include the Wall Batter in the 
Geometry when calculating Wall weights, moment arms, etc.  As a result, we will now use the actual 
wall batter, even if it is under 10 degrees, to more accurately model the Walls with respect to Geometry 
as shown in the figure below.  The applied external forces will still act on the vertical interface.  Note 
that the weight W4 is not included as it lies outside of the vertical interface.  This is not consistent with 
the NCMA approach, which simply approximates Wri as a rectangular shape with height (H) and depth 
(L).  Not including W4 may therefore give an overly conservative result.  To check this, you can set your 
Wall batter to zero and compare.     

 

Item 23 AASHTO 2015, Seismic (August 2017) 

One of the main changes to AASHTO for 2015 was the calculation of total Horizontal Thrust (Seismic).  
Thf had to be checked for three conditions to get the maximum value.  The three conditions (per 
C11.6.5.1) included: 1) 100%Pae+50%Pir, 2) 50% Pae +Pir, and 3) Unfactored Static Loads+Pir.  This was 
incorporated when 2015 was included in Vespa.  The max of these was used where dictated by AASHTO 



(Base Sliding Calculation).  Upon reviewing this again recently, it was determined that if the intent was 
to always look at these combinations, they should also be applied to the new Overturning Moment 
calculation that was added in April of 2017 (on top of the existing eccentricity check that was already in 
place).  As such, the load combinations are used to determine the maximum overturning moment and 
bearing eccentricity.  This is not explicitly defined in AASHTO, however, we believe it is in line with the 
intent of C11.6.5.1.   

Item 24 – AASHTO Load Factors (August 2017) 

When AASHTO 2015 was introduced to Vespa, the Load Factors/Resistance Factors were separated from 
being a single variable that was either set to a Min or Max value (depending on the use), to what we 
have now, which is a separate variable for the Minimum Load/Resistance Factor and another one for the 
Maximum Load/Resistance Factor.  This made the coding clearer and also allowed us to format the 
Design Criteria table better.  There was one case reported where upon updating the database, a 
duplicate value for the Live Load Factor (Max.) was created and it was a corrupt value (set to 0 instead of 
1.75).  Additional checks have been added to ensure duplicate values are not created, however, for 
older files, ensure to check Load/Resistance factors are not duplicated or have incorrect values.   

Item 25 – Changing Blocks/Geogrids on Existing Designs (August 2017) 

Some users wanted the ability to change the SRW units/Facing in a Wall, without wiping out their 
Geogrid Reinforcement Design.  We have now added the ability to do this.  If you select a new Facing, 
different from the current one being used in the Design, as long as it has the same face dimensions 
(Block Height and Block Length) AND it has connection testing with the existing Geogrids, the Facing will 
be replaced. Keep in mind, this does not automatically mean it will pass all criteria the previous facing 
may have (as connection properties may change), so you have to run the analyze all routine again. 

  



Updates – September 2017‐December 2017 

Item 26. Significant performance improvement when generating or analyzing, or copying left/right 
 

Item 27.  Apply All added to Loadings screen. This makes it quicker to apply loading to all panels instead 
of extend left and right. 

 
 

 

Item 28. Panelization improvement – In some situations, previous panelization routine could create ½ 
block width wider than it needed to. 
 
Item 29.  Change to never consider coping in calculating needed embedment (now includes in % of 
height). 
 
Item 30.  Improved handling of RsTop/Bottom during generation, and in conjunction with a block’s max. 
separation 

 
Item 31. Better handling of potential pullout errors on a grid too close to grade 
 
Item 32. Improved handling of uniform grid lengths 

 
Item 33. Soil type on reinforcement screen now applies to all selected reinforcements, no longer allows 
diff. settings for each 
 
Item 34.  Option to ignore crest toppling during generation. Sometimes this is useful if you know you will 
be putting a small secondary layer of grid at the top, but do not want to have your top layer of grid 1ft 
from the top (and get crazy lengths).   

 
 



 

 
Item 35. AU (Australian) Code: structure importance classification now on project screen and better PDF 
output.   
 
Item 36. Can edit file names for DXF export 

 
Item 37. Improvement on how NCMA and AASHTO handle load offsets.   For External Stability, AASHTO 
and NCMA do not really provide a graduated way of reducing surcharge loads if they are offset beyond 
the back of the reinforced zone.  We have implemented a simple approach where the load would be 
reduced according to the offset distance.  For example, in NCMA, a factor (called a qdfactor) would be 
applied to the Live/Dead load according to the following: 

 

For AASHTO it would be: 

 

 



Item 38. NCMA Seismic Analysis 

For situations where the values entered for phi angle, back slope and Seismic Kh are incompatible with 
the M‐O analysis, Vespa previously brought up the warning (which the user had to agree to) which 
stated that an “Alternate Seismic Method” was used.  This Alternate Seismic method was the “Trial 
Wedge” approach, which analyzed potential failure planes behind the reinforced zone on 1 degree 
increments to solve for the maximum thrust (more information available upon request).  In the latest 
version of Vespa, we are requiring that the user more explicitly agree to this approach by selecting it as 
an option in the Settings/Options/Analysis.  When the option is turned “ON”, the Trial Wedge Approach 
is automatically run when the condition exists: 

 

If the option is not on, the industry standard “stop‐gap” method of setting this term = 0 when it is 
negative.   

January 2018 

Item 39.  Offset Loads and Reduction Factors ‐ Option 

As noted in Item 37, we have provided a way to reduce Live and Dead loads based on Offset Distances. 

However, we have updated Vespa to have this as an Option the user selects for NCMA, rather than just 
automatically utilizing it, as this is not explicitly discussed in the NCMA Design Methodology.   

As well, we have included a further method to reduce loads for internal stability based on offset as 
described below.   

To review, for AASHTO, External Stability, a Factor for the Live and Dead load is calculated as follows: 



 

This factor is then applied to the Driving Live and Dead forces, F2 and F3.  Because AASHTO is silent on 
how the offset load can be gradually reduced, we have made the conservative assumption that the 
maximum influence distance from the back of the Wall is equal to 2H.  This factor is automatically 
utilized during the analysis.   

For AASHTO Internal Stability, the result is not graduated and basically applies the full Live or Dead Load 
if the Offset is within the Reinforced Zone. 

 

For NCMA, the user is given the option to either run “Standard” NCMA handling of offset loads as 
described in the NCMA Manual (3rd Edition), OR, choose to more accurately reflect the load offsets 
according to the following calculations. The Option to choose this is in the Settings: 



 

For External Stability, the Qdfactor and Qlfactor are calculated as follows: 

 

For Internal Stability, a similar approach to the NCMA method is used, however, instead of the 2V:1H 
influence line assumed by NCMA, a more conservative 1H:1V influence line is used.  However, although 
we are more conservative from the distribution point of view, we then apply this reduction to all 
internal modes of failure (Tensile Overstress, Pullout, Connection), as opposed to the NCMA, which just 
applies it to Connection.  

As with NCMA, the intercept height on the back of the Wall facing is calculated (assuming a 1H:1V 
distribution.   

 



An individual Load Reduction Factor is then calculated for each layer of Geogrid as follows: 

 

 

 

 

 

 



 

 

 

 

Item 40 – New PDF Output Options 

In the PDF output dialogue box, you can now select multiple Panels from any Wall within a given Project. 
For example, if you wanted to print out the detailed calculations for Panel 5 in Wall 1, Panel 3 in Wall 2, 
and Panel 10 in Wall 3, you can select each of these Panels in the new selection box and they will be 
compiled in a single report.   

 

 

Item 41 – March 2018 ‐ Improvement when Switching between Methodologies 

In a given Project, if the user was switching between different Design Methodologies, such as NCMA to 
AASHTO, the user would have been required to go to the Reinforcement Tab to reset the related 
Connection Data.  New coding has been added to ensure the user can move directly to the 
Design/Analysis without first going to the Reinforcement Tab to get the AASHTO Connection Creep and 
Durability values.   

Item 42 – March 2018 – NCMA Crest Toppling 



Some Vespa users noted that the NCMA Seismic Crest Toppling calculation yielded a different result 
than the “same” Overturning calculation when analyzing an independent conventional Wall of the same 
height and loading conditions. This is due to some inconsistencies in the NCMA Design Methodology. For 
Static Crest Toppling, NCMA currently uses Beta(int) and Ka(int) in the analysis.  Calculation of Beta(int) 
is based on the full Wall height, but should be based on only the smaller Crest (gravity) height of the 
Wall.  As such to be more accurate, we need to create a couple of new variables to account for this.  

First, for Static Crest Toppling, we create a new variable called hmaxCREST 

 

This variable is then used to calculate a new Beta value (just for Crest Toppling) 

 

Based on the new variables, a new Kaint(CREST) is calculated. Note that we are still using the infill 
friction angle instead of the Retained friction angle as it is assumed the “reinforced” material extends to 
close to the top of the Wall.  

 

We assess the effect of offsets on applied Live and Dead Loads as follows (if this option is ON) 

 

Crest Toppling calculations continue per NCMA based on the above new variables.  

For Seismic Crest Toppling, the major difference here is the assumption that the Internal Inertial Angle 
should be applied to the Kae (int) equation. However, if this small (Crest) Wall was considered as an 



independent gravity wall, the External Inertial Angle would apply, which we allow deflection to apply. As 
a result, the current Seismic Crest toppling often results in higher seismic loads than the equivalent 
Gravity Wall. To balance this, we have included the Option in Settings to allow the khext to be used in 
the Crest Toppling analysis.   

 

 

The new Kae(int) CREST would then be: 

 

 (Note – because the new approach does not strictly follow NCMA, although it is more correct, the user 
will have to select the Option in Settings).    

Item 43 – Reformat PDF Output 

The detailed calculation output tables have been reformatted to be more consistent from Methodology 
to Methodology, particularly for gravity structures, highlighting the applied loads, then resisting loads, 
followed by the associated FS or CDR value.   

 

Item 44 – NCMA : Addition of Qd and Ql Factor for Internal Sliding (May 2018) 



As noted in Item 39 above, we provided the user a way of accounting for offset Live and Dead Loads in a 
“graduated” way.  By applying a Qd (Dead Loads) and Ql (Live Loads) Factor to External Stability, we are 
able to gradually reduce loads with offsets.  Until this build, we only applied these factors to External 
Stability.  We are now applying these factors to the Internal Sliding Calculations as well.  As the actual 
Wall height decreases with each Geogrid Elevation analyzed, application of the Ql and Qd Factors from 
External Stability will be a conservative approach.   

Items from this point forward relate to Vespa and Vespa 2 

Item 45 – NCMA: No Fines Analysis 

The current No Fines Analysis follows the typical NCMA Conventional Analysis, where the Base Sliding 
Resistance is calculated based on the friction along the Gravel Base.  Some users have indicated that 
while the Base Block (SRW) may be on the Gravel Base, the “No Fines” portion of the mass may not be.   

As such, part of the Mass is sliding along the Gravel Base, and part is bearing directly on the Foundation 
Soil.  To err on the conservative side, we have changed the standard analysis to utilize the Foundation 
Soil Friction Angle in the Base Sliding Resistance Calculation.  If this is not the case in your application 
(entire mass is bearing on a Gravel Base), increase the Foundation Soil Friction Angle for your base 
sliding calculation.  Make sure to change it back to check Bearing Capacity calculations.   

Item 46 – Formatting Bug in PDF output 

For Reinforced Walls, the FS/CDR Table in the PDF output was showing the values for Internal Stability 
for each layer of geogrid in reverse order relative to their elevation.  This has been fixed. This was just a 
formatting issue – the values are correct, they were not being displayed in the correct order. 

Item 47 – Explanation of Crest and Toe Geometry Extrapolation 

Some users have asked for a more comprehensive explanation of how Crest and Toe Geometry are 
extrapolated between Stations and Panels.  For this build, we have modified the way it interpolates 
between Stations that we feel is more intuitive.   

When entering stations, crest and toe information can optionally be entered for each station. When the 
crest or toe option is first turned on, the corresponding fields will show in red as “calc” indicating that, if 
nothing is entered for any of these they will be calculated for you once you complete your entries and 
either press the Validate button or move off the Stations screen. 

Along with entering offsets, an additional option allows entry of either elevations (feet or meters) or 
slopes (degrees). This option can be toggled at any time, entered values will be converted as needed. In 
order to be of any purpose at least one offset and one elevation/slope must be entered for crests and 
the same for toes (a single offset could be entered for one station and a single elevation/slope entered 
in a different station). 

Station Resolution 
When validation of stations occurs, entered values are extrapolated in order to fill any missing (‘calc’) 
values. If nothing is entered for a value in the first or last stations these will default to minimum values – 
offsets will be set to zero and elevation will be set to that station’s Top value for crests or Bottom value 
for toes (will show as 0 degrees if entering as slopes). 



For all other missing values, they are calculated based on that station’s X position along a plot line 
between the containing stations having values with Origin as the X value and the offset or elevation as 
the Y values (note that even if entered as slopes, this process uses the corresponding elevation values 
for this process). First missing offsets are calculated, and then elevations.  

A simple example to understand would be a case of 4 stations entered at equal intervals with the first 
crest offset set to 0 and the last set to 12 feet.  This process would fill in the two missing offsets with 4 
and 8 feet. Likewise, if crest elevations were entered for first and last stations of 10 and 13 feet, the 
missing elevations would be set to 11 and 12 feet. If slopes are being displayed instead of elevations, 
these will then be calculated accordingly. 

Panel Resolution 
When the stations are “panelized” using the selected wall unit, crest and toe data entered and/or 
calculated for stations is applied to each of the generated panels. For each panel, the set of stations 
affecting it are determined. The offsets and elevations for these are then plotted and from that the 
points on these lines for the left and right sides of each panel can be determined. In addition to the left 
and right sides of the panels, there may be one or more stations within the panel’s bounds. The Design 
Height for all of these is computed and the largest Design Height determines the controlling values for 
this station. For example, if each panel in a wall is growing in Design Height from left to right then the 
right side of each panel will be the controlling station and values at this position will be used to set the 
crest and toe values for that panel. 

Item 48 – NCMA Load Offset Option (May 2018) 

In Item 39 above, we explained an option that was added in 2018 to allow the user to conservatively 
reduce Live and Dead Loads based on offsets. This option expands on what the NCMA methodology 
current offers.   

We have made two changes to how this option works, based on feedback from users.   

1. For Internal Stability Analysis, the NCMA provides guidance for load reductions due to 
offsets for Connection and Crest Toppling.  Since this method was already in place, we 
maintained this approach for analyzing Connection loads, even when the “Load 
Reduction” option was ON.  We applied the new offset reduction method to Tensile 
Overstress and Pullout.  This was inconsistent due to the fact that the NCMA approach 
assumes a 2V:1H line of influence for Connection, and we were applying a 1H:1V line of 
influence for Tensile and Pullout.  Therefore, if the Load Reduction option is “ON”, the 
Geogrid Loads (Fgn) are reduced the same for all modes of failure (according to the 
method described above in Item 39).  If the option is OFF, the Connection loads are 
reduced according to the NCMA.  
 

2. For Internal Sliding, we were conservatively not applying the load reduction factors that 
we did for External Stability (Base Sliding). We have included these to be more 
consistent when the Load Reduction option is ON.  

 

 



Item 49 – NCMA Seismic 

For the calculation of the Weight of Slope above the Wall (Wbeta), Vespa uses the unit weight of the 
Retained Soil, as experience has shown that typically retained or native soils compose the slope as 
opposed to the infill soil.  Recent review of our code indicated that for the calculation of the modified 
slope weight (W’beta), the infill unit weight was being applied. We have changed this to be the retained 
unit weight to be consistent.  The difference in results will likely be negligible in most cases.   

Item 50 – PDF Output 

To make it easier for users to identify which Cross Sections they may want to print out (Section Analysis 
Summary, Detailed Calculations, Equation Report), the Grid Group Designation (A,B, C, etc) is now 
shown beside the Panel in the PDF output dialogue box.  As shown in the image below, the Panels show 
an orange letter beside them indicating which Grid Group they are part of.  Note that the Highest Panel 
in each Grid Group is shown with an asterisk beside the letter.  Using this convention, a user can easily 
select the highest panel of each grid group to print Section related data.   

 

 



Item 51 – NCMA Crest Toppling 

In Item 42 (refer above), we discussed how we dealt with slopes above the Wall Crest.  As noted, the 
NCMA Methodology uses Beta(int) that in the Ka equation for Crest Toppling.  Beta(int) is calculated for 
all internal stability calculations based on the entire Wall Height (equivalent slope when you have 
broken back conditions is based on 2H).  We have identified that as not being completely accurate, as 
we are just looking at the Crest Height in the Crest Toppling Calc. As such, we revised the Beta (int) 
specifically for Crest Toppling, which yielded a new Ka(int)CT.  While this approach is more correct and 
more accurately reflects/models the slope conditions, it is technically not NCMA compliant.  As such, we 
have added another option in the Settings/Options/Analysis menu which allows the user to use the 
Alternate Ka(int) for Crest Toppling as shown below. 

 

Item 52 – Additional Information in “Project Information/Quantities” 

In the Project Summary, we have added the Tallest Panel Height and Longest Reinforcement Length, as 
these are typically good indicators of the size/scope of the Wall.   

 



Item 52 – Split/Merge Panels and Loading – August 2018 

When a Panel is Split, the loading from the original Panel is automatically copied to the new (Split) 
Panel. The Slope and Slope Offset was being automatically copied, but Live or Dead loads were not 
automatically being copied over.  This has been corrected.  

Item 52 – Top of Base Label is DXF – August 2018 

A bug was fixed where the TOB (Top of Base) value in the DXF was not being shown in the last panel.   

Item 53 – PDF Output – Oct 2018 

A bug was fixed where the height of the Cross Section shown in the PDF did not correspond to the 
drawing (graphic) that was being shown.   

June 2019 

Item 54 – Text/Font Size in Design/Panels Tab 

When running Vespa2 on some laptops, the smaller screen and high resolution resulted in the Text 
Boxes on the Loading/Design/Panels screen to be enlarged.  We have reduced the font sizes in these 
Boxes to appear more reasonable on a smaller screen.  This is more of an issue with how Windows 
handles the fonts.  

 

Item 55 – AASHTO 2015 Slope Weight 

For the slope above the Wall, the Soil Type has been assumed to be Reinforced/Infill.  More typically, we 
see that the actual Soil Type in this area is more similar to the Retained (Native).  We have changed this 
due to user feedback.   

Item 56 – Addition of Multi‐Depth Gravity Walls 

Vespa 2 now includes the ability to generate and analyze Multi‐Depth Gravity Systems in general 
conformance to the NCMA Design Methodology.   
 
Multi‐Depth Systems can be selected from the list of preloaded Products in the Wall Unit Tab (for 
Licensors that have provided this information), or, they can be defined as “User Defined” Systems in the 
Settings/Wall Units menu. 
 
To select a Preloaded Multi‐Depth Set (System), go to the Wall Unit Tab, select the Licensor and Product 
Line, then click on the “Select Multi‐Depth Set” toggle.  



 
 
Only the Preloaded Systems that are Multi‐Depth will now be shown in the Wall Unit Drop Down Menu.  
In the “Settings” Tab that appears to the right of the Drop Down Menu, a couple of options are provided 
as shown below. 

 
 
In the settings, we can see that for this particular Multi‐Depth system, there are two units being utilized 
(one is 925 mm deep and the other is 500mm deep).  First, you set the “Wu Factor”, which is an 
empirical limit you can apply to the maximum height any block can go as a gravity wall based on the 
block depth.  For example, if the block depth is 2.0ft, and the Wu Factor is “2”, the maximum allowable 
height that block could go is 4.0ft.  Second, you indicate which of the Blocks should be used for the 
Geogrid sections in the Wall.  The Multi‐Depth Engine allows you to have both Gravity and Geogrid 
Sections within the same wall.  As such, you can set which block should be used for the Geogrid Sections 
here.   
 
Once the system is selected, if you plan on using Reinforcement for some sections, go to the 
Reinforcement Tab and select your reinforcement as before. 
In the Soil Conditions Tab, the Drainage Layer is defaulted ON for a Face Drain.  You must input a unit 
weight of Drainage Soil (Default is provided), as this is used in the calculation of your Wall Weight.   

 
 
After you input your stations and go to the Panels Tab, you will see that a Preliminary Multi‐Depth 
layout is provided (shaded portion is the larger Unit at the bottom of the Wall). This preliminary layout is 
only based on the Maximum Wu values you set in the “Settings” and is NOT A DESIGN.   



 
 
 
In the Loading Conditions, we see the Cross Sections, which contain a mix of smaller and larger units as 
shown below. 
 
 



 
 
Again, this layout of smaller and larger units is not a Design, just a preliminary layout.  Include your 
loading as before and move to the Design Tab. 
 
In the Design Tab, the default for the “Generate” function is to generate a Multi‐Depth gravity Wall.  If 
you need this particular section to be a Geogrid Reinforced Wall, set the option to “Force Reinforced”. If 
not, leave it unchecked.  Note that if you select multiple panels in the Design Screen, and the Force 



Reinforced option is ON, it will design those panels as Geogrid Sections, and leave the other Panels as 
Gravity Sections.  However, if the “Generate All” button is selected, the Generate function will attempt 
to design the sections as Gravity Walls, but if they do not pass, it will switch to Geogrid Sections if a 
Reinforcement is selected.   
 

 
 
The  Generate function for Multi‐Depth Walls works as follows.  First, it checks to see if the section will 
work using the largest unit, for the full height.  If this does not pass, unlike a Grid reinforced Wall, 
nothing further can be done and it will just show the failed result. (A Grid reinforced wall can increase 
the length, number or strength of grids in an attempt to pass.  A Multi‐Depth Set is limited to the 
maximum depth of the largest block in the set).  
 
If this first test passes, the Engine works for the top‐down.  Using both the empirical limit of Max. Wu 
and full analysis calculations, it determines the maximum height of the first depth of block at the top of 
the Wall.  In this solution, it has determined that the smaller block can achieve 7 courses at the top of 
the Wall. 

 
 



Next, it checks the Total height of the Wall again, using the Drainage Material unit weight as part of the 
upper portion of Wall.  Note that this is different from the first check, where the entire Wall height was 
assumed to contain the Largest block.  If the Total height does not work with the new arrangement 
(partial Drainage material as weight), then the engine continues to add larger blocks until it does.  
 
If the system had three different Block depths, it would run one more iteration in the process.  
 
In the Full Output, we can see that the calculations show a FS for each mode of failure, at each level 
(small block, large block). There is only 1 FS for Bearing Capacity, as it is for the entire structure.  
 

 
In the above example, we chose a “Multi‐Depth Set” that contained two different Block depths.  The 
new MD Engine also has the ability to stack a single Block Increment to any depth 
 
To create a User Defined For a Multi‐Depth System, you have to first create the block as shown above 
(following steps 1‐4 above for all depths of your Multi‐Depth System.  For example, if your MD System 
has 3 depths, you would create three separate blocks, such as “System A 300”, “System A 600”, and 
‘System A 900”.  These three blocks would represent three different depths (front to back depth) within 
the same system.  You could add Geogrid Connection properties to these blocks as well if you wish.  
 
Once the blocks are created, go to the new Multi‐Depth Tab on the right side. In this Tab, you have two 
different options to create a Multi‐Depth System.  
 
Option 1 – Set Unit Sizes 
This option is for a system that has between 2 and 3 Units that have a set depth (i.e they are 
manufactured to a set depth). We call this a Multi‐Depth Set.   
 
 



 
 
Select “New” and enter the Name of the Set.  Then, Select your “Base Unit”, which is the largest 
(deepest) unit, your Intermediate Unit (middle depth) and your Top Unit (or just the Intermediate/Top 
Unit if you only have two different depths in your system). 
 
The Wu Factor on the Right side of the Intermediate/Top Drop Down Menu indicates the maximum 
height of Wall that unit can be used for, as a function of the block depth.  For example, if I have a block 
depth of 500mm, and a Wu Factor of 2.5, the program will not stack that unit more than 2.5 x 500 = 
1.25m in height.  This is also how it determines the initial layout of the wall.   
 
Then hit Save.  
 
Option 2 – Incremental Multi‐Depth Wall 
If you want to create a MD system that uses a single block (module) to create various Wall depths (by 
placing them immediately behind eachother), use option 2. 
In this option, we name the “set”, just as above, then select our Base Unit from the Drop Down. In this 
case, it would be the single block that we are using the incrementally create the Multi‐Depth Wall.  Once 



the Base Unit is selected, we set the Maximum Units/Course value to greater than 1.  This value 
represents the maximum number of these units you would ever use to create a multi‐depth structure. 
For example, if our Base Unit or Module is 500mm in depth, and I know that I would never place more 
than 4 of them back to back (for a depth of 2.0m), this number would be 4. 
When this value is set to anything above 1, the Intermediate/Top Unit Drop Downs disappear, as the 
system now knows this is an “incremental” multi‐depth system, not a “Set” System described above. 
 
Item 57 – April 2020 

New Graphic Interface.   

A new DirectX Graphic interface was implemented, which solved the sizing issues users were having with 
small (laptop) screens.  In the past, graphics generated on smaller screens where not handled properly, 
and became distorted or flipped.  The new Graphics system allows Vespa2 to be run on almost any size 
of screen, while maintaining the integrity of the images.  The DirectX interface is also much cleaner, less 
pixelated, and clearer than the previous version. 

Item 58 

AASHTO 2015 Revised to Include Live and Dead Strip Loads 

For a full set of calculations, please contact support@ctiware.com. 

Item 59 

AASHTO 2020 Simplified Method and Inclusion of Live and Dead Strip Loads 

Item 60  

AASHTO 2015 and 2020 – Modifications to Calculations 

a. For AASHTO 2020, the Coulomb earth pressure coefficient is now allowed, which utlizes the Wall 
batter (omega), even within the previous 10 degree minimum.  Also, the External Interface 
Friction Angle is calcuated as the minimum of 2/3 x the Reinforced Internal Friction Angle or 
Retained Internal Friction Angle.  Previously, this value was set to the External Beta.  For a full 
set of Calculations, please contact support@ctiware.com. 
 

b. For AASTHO 2015, in cases where a Broken Back Slope existed, we based the calculaton of 
equivalent Beta, or I, on the diagram shown below (AASHTO 11.6.3.3 and 11.10.5.5). As seen, 
even in the case where the Slope broke within the reinforced zone, a value for Beta External 
could still be greater than 0 degrees (based on 2H).  For External Stability, a more accurate 
approach to modelling this would be to set the Beta External equal to zero, as there is no 
“actual” slope beyond the reinforced zone in this case.  As a result, this will reduce the External 
Ka value, and associated Forces.   
 



 

 
c. For Base Sliding Resistance, the conservative assumption was originally made to reduce the 

Foundation Cohesion by the Friction Factor, mu.  This assumption was incorrect, as these modes 
of resistance are independent of eachother. The result was overly conservative Sliding 
Resistance values in the situation where Cohesion was used.  This has been fixed.  

 



Item 61 

Introduction of Awall2 and new Vespa2 Plan Import 
Function 

Based on user feedback, the new Awall2 has been upgraded 
as follows. 

1. Crest and Toe Geometry Inputs 
At each Station, the user can now input Crest and Toe 
Elevations and Offsets, which will then be imported directly 
into Vespa2.   

 

 

 

 

 

 

2. Option of Drawing the Top or Bottom of Wall 
Line. 

By selecting either Top of Wall or Bottom of Wall, the 
user can specify which direction the Wall is projected 
when the “Create Wall” function is used.   

The “Top of Wall” option is the way Awall has always 
operated. This assumes that the “Baseline”, or line you 
draw to represent the Wall, is the Front Edge of the Cap 
Unit on the Wall.  As such, the Create Wall Function 
projects “Down” from this to create the outline of the 
Wall Batter.   

The new “Bottom of Wall” option now assumes that the 
line you draw to represent the Wall is the actual Bottom 
of Wall, where it intersects the Grade in front.  As such, 
the Create Wall function projects “Up”, to create the Cap 
Unit at the Top of the Wall.   

 

 

3. Plan View Import / Export 
When the Export Function is used in Awall2, the “Plan View” of the Baseline is now included in the File.  
As such, when the Station Data is imported into Vespa2, a new Tab is created which accurately shows 



the true Plan View of the Wall.  When the Wall is then Designed, whether using Gravity Blocks (Single or 
Multi‐Depth), Geogrid Reinforcement, or No‐Fines concrete, the Plan View is updated to represent the 
true footprint of the Wall, include block depth, wall batter, depth of reinforcements, and/or excavation 
limits.  This Plan view can then be exported back to CAD (DXF) to overlay on an existing plan.  This 
feature is very useful to determine potential conflicts with the Wall/Reinforcement and the Site 
(property lines, other structures, easements, etc).   

 

Item 62 –  

Plan View Import/Export updated.   

 

Item 63 –  EV/LL Option added.  For all AASHTO Design Methodologies, an option was added to use the 
Vertical Earth Pressure Load Factor (EV) for Internal Tension calculations as opposed to individual Load 
Factors for each potential Load (Earth, Live Load, Dead Load).   

 

Item 64  

AASHTO ‐ Eccentricity Check presented as CDR value as opposed to binary check. 

Item 65 – When large Toe Slopes present, Cross Section display was not centering image. Fixed. 

Item 66 – DXF output – Applied Bearing Pressure labels were not being output when Wall mixed Multi‐
Depth Gravity Structures with Grid Reinforced Walls. Fixed. 

Item 67 – NCMA Multi‐Depth Gravity Analysis – New Method of inputting System.  

A new method has been added to enable the user to add Multi‐Depth Gravity Wall systems that are 
composed a combination of Facing Elements, and Tie‐Back Modules, such as a Crib Type System. 

In Item 56 (above) we discussed the addition of Multi‐Depth Gravity Walls.  To now include Crib type 
Wall systems or other “Tie‐Back” Gravity Wall Systems, a new method of entry has been provided.  
NOTE: The Gravity Analysis checks External Stability of the Wall ONLY.  Internal Stability of the Wall is 
not considered and would be the responsibility of the System Manufacturer.  This would include 
internal shear/tension between Tie-Back Members and Dead Man or Facing Elements, etc.   



Under Settings/Wall Units you will see the regular Dialogue Box for Facing System Maintenance.  In the 
Properties Tab you create the Face Element first.  This is done by selecting User Defined from the 
Licensors Drop Down Menu.  Select “Block” as the Unit Type then enter the Properties (dimensions, unit 
weight, shear capacity, etc), then hit “Save”.   

 

Once the Facing Element has been defined, you can now create a Tie‐Back or “Extender” Unit. This type 
of unit can only be used as a Multi‐Depth component, and cannot be used in a Wall by itself.  To do this 
select New again, then “Extender” from the Block Type.   

Now input the Extender (Tie‐Back) properties.  The % Hollow Core accounts for the infill volume in the 
Crib, so this must be determined in advance.  Note, the Face Height must be the same as the Facing 
Element previously defined to be used together.  Note that the Shear Capacity of the Extender must be 
specific to this unit, not that of the Facing Element.  



 

Then hit Save.  

You can add an additional Extender Unit with a different Depth as well.  For example, if you had a 
second type of Tie Back that was 600mm in Depth, this would be added in the same way. 



 

Go now to the Multi‐Depth Sets Tab.  Select “New” and name your new Crib System, then select “Multi‐
Depth with Extenders”.  Now you can select the Face Unit you just defined.  Below this you have the 
option of selecting up to 2 different Extender Units. You must select the Shorter one first, then the 
Longer one. In our case, we just have 1 Tie‐Back or Extender unit, so we will select it in the Shorter Unit 
Drop Down Menu.  Then hit Save. 

 

If we create a new Project and select the User Defined, Multi‐Depth Set we just created, the Wall will 
first Panelize using the Facing Element only as shown here. 



 

 

In the Design Tab, if you select Generate All, Vespa will analyze each Section and add Extenders as 
necessary to meet the minimum FS required.   

 



You can manually add Extenders at any Course by clicking on that Course, then Right Clicking to bring up 
the Menu.  In the Menu you will see an on option to “Change to Longer Depth” or “Change to Shorter 
Depth”.   

  

This will result in adding a Longer Depth to that course and all those courses below it. Note that it starts 
with the Shortest Extender. 

 



This process can continue by simply selecting the Longer or Shorter Depth again from the Right Click 
Menu.  

In the Quantity output, the number of Facing Units, Extender 1 and Extender 2 are provided.   

Item 68 – AASHTO 2020 Internal Resistance Factors 

From AASHTO 2015 to AASHTO 2020, the default values for the Resistance Factors for the Internal 
Stability Analysis changed as follows.   

Pullout –   0.9 (2015) / 0.7 (2020) 

Connection –   0.9 (2015) / 0.8 (2020) 

Tensile Overstress –  0.9 (2015) / 0.8 (2020) 

The default values did not update automatically in the Design Criteria Tables and the user was required 
to modify them.  This has been corrected and the default values now update to reflect the changes.   

Item 69 – AASHTO External Stability: Horizontal and Vertical Components 

As noted in Item 60 above, for AASHTO 2020, the Coulomb earth pressure coefficient is now allowed, 
which utlizes the Wall batter (omega), even within the previous 10 degree minimum.  Also, the External 
Interface Friction Angle is calcuated as the minimum of 2/3 x the Reinforced Internal Friction Angle or 
Retained Internal Friction Angle.  Previously, this value was set to the External Beta.  While we did 
incorporate this change into the Ka calculation, we conservatively kept the External Beta to determine 
the Horizontal and Vertical Components of the Lateral Soil/Surcharge Loads.  AASHTO allows use of the 
Interface Friction Angle in place of External Beta, however, the current representation of the AASHTO 
equations do not account for the Wall batter (omega).  To properly account for the Wall Batter, we have 
adopted the following modified version of the Horizontal and Vertical force calculation. 

AASHTO 2020 –  

 

AASHTO 2020 (Vespa) –  

 

We believe this is the intent of the Equation, however, it has not been explicitly shown, likely due to the 
application of many vertical MSE Walls (Panel/Steel Reinforcement) represented in this document.  

 



Item 69 – Secondary Reinforcement 

This version includes the option to include Secondary Reinforcement (SR) in the Wall.  At this time, the 
SR is only used for quantity estimation purposes and visual representation.  The SR is not included in the 
Wall Analysis.  Some users include smaller layers of geogrid near the top of the Wall for local stability 
against handrail and fence loads, for example, which is the main purpose of including the SR in this form.  
We do provide the option of placing small layers of SR between layers of PR, as this does have some 
beneficial effect on reducing Connection Loads, however, it is not accounted for in the analysis as noted.  

To access the Secondary Reinforcement Option, go to Settings/Options/Reinforcement Tab.  You will see 
a toggle for “Enable use of Secondary Reinforcement”.  

 

When you enter the Reinforcement Tab in your project, you will now see the option of setting a 
particular geogrid as the “Secondary Reinforcement”.  This geogrid can be used as the primary as well.  



 

In the Design Tab, you can run your normal “Generate” routine to establish the Primary Grid.  
Remember, the analysis does not consider the Secondary Grid, so the Wall has to work using only the 
Primary Grid first.  Once the Wall is designed, you have 3 options for applying the Secondary Grid; 
Manual, One/Primary Interval, and Every Available Course.   

 

If you are just putting a small layer of Grid at the Top of Wall for example, you can select Manual, then 
enter the Grid Length.   

 

You would then click on the Block that you want to put the Grid on, then Right Click to bring up the 
Menu.  Then Select “Add Secondary Reinforcement” 



 

The reinforcement is then added.  You can Copy this placement to all Panels by selecting “Copy to All”. 

 



If you would like to place a SR layer between all primary layers, select One/Primary Interval, and one will 
be placed between existing Primary layers.   

 

If the final option is chosen, a SR layer will be placed on every available course.   

We plan on expanding the use of SR as more is incorporated into future Methodologies.   

Item 70 –Internal Compound Analysis – Important Update 

For the ICS Analysis, it was determined that a bug existed in the code that resulted in the over-
estimation of the contribution of Grids Forces for Static Analysis.  Through a parametric analysis, on 
average the F.S. was overstated by 2%-10% for high walls (>15ft) with steep slopes and/or a 
combination of a slope with surcharge loading (Broken Back), although many factors will affect these 
numbers.  This has been fixed.  We have now provided additional methods of modelling ICS more 
accurately.  In the Settings under Options/ICS, we have the option of setting the grid orientation relative 
to the tangential angle of the failure surface.  When the ROR value is on, the grid is tangential to the 
failure plane.  AASHTO recommends using the ROR for extensible (geogrid) reinforcements when RC=1,  
unlike Steel Strips or Matts for example.  As an additional measure, we have provided for the inclusion 
of cohesion in the Retained Zone.  As always, caution must be used when applying cohesion in any slope 
stability analysis.   

It should be noted that the ICS calculation is not a substitute for a proper Global Stability Calculation 
conducted by a qualified Geotechnical Engineer.  The Geotechnical Engineer is responsible for the final, 
complete Global Stability Analysis “around and through the SRWs” (Refer to Secton 3 NCMA Manual, 3rd 
Edition).   

 



Item 72 – Multi‐Depth Analysis 

Discussion of Assumptions and Addition of Swale Option 

The Multi‐Depth Gravity model is based on the NCMA Conventional Analysis.   As the NCMA does not 
explicitly deal with Multi‐Depth Gravity Structures, the basic NCMA model was followed, with the 
following modifications.   

The standard Conventional Model assumes a fixed unit depth and material unit weight.  The Multi‐
Depth model is a combination of Concrete Units (filled or solid) and Drainage Backfill as shown below. 

 

The initial Model allowed for 3 Unit Depths (Sets), like what is shown above.  Typical Unit Depths might 
be 1.0m, 0.5m, and 0.3m, for example.   

The Multi‐Depth model followed the NCMA conventional approach where 
the Wall height at the back of the Wall was equal to the H.  This 
assumption was based on the fact that even with relatively high Gravity 
Walls, given the wall batter, limited depth relative to height, and standard 
Swale geometry, the Hext is only nominally different than H.  However, 
with the introduction of the of the Crib/Extender option, the potential for 
deeper and higher walls exists.  Therefore, to model the Multi‐Depth 
Gravity geometry more accurately at the top of the Wall, an option has 
been provided to include a Swale.   

When running a Multi‐Depth analysis, in the Design Tab you will see an 
input field called “Swale Width”. The NCMA Best Practice Guide 

recommends a minimum of 0.9m (36”) for the Swale Width (Refer Chapter 4 – Water Management and 
General Design Considerations).  If this is selected and a value is input (1.0m for example), the analysis is 
modified to account for this new Geometry.   

The Swale will be shown as a dashed line to indicate it is considered in the Analysis as shown below. 



 

For the Extender Option, it must be noted that the analysis is limited to External Stability (Base Sliding, 
Overturning, and Bearing), and Internal Shear Resistance.   As many of these Crib/Extender systems are 
proprietary in nature, the Internal Stability of the Connections between units (such as Tie‐Backs for 
example), Tensile and Moment Resisting Capacity of members within the system, are the responsibility 
of the Vendor and are not checked or verified in the analysis.   

An additional Interface Shear check has also been added to the Top of the Base Course.  Previously, we 
checked each new Tier for Interface Shear, then the Base Course was the traditional Base Sliding Check.  
The assumption was the bottom of the Base Course (sliding along the gravel base) would always have 
less sliding resistance than the top of the Base Course, as this would typically have some mechanical 
shear connection (key/groove) as well as friction.  As this may not necessarily be true in all cases, the 
additional check was added.  

Item 73 – Multi‐Depth Analysis Copy/Paste Functions 

When designing a complete Wall, we have added the ability to Copy/Paste and Extend Left/Right the 
Multi‐Depth configuration.  The configuration of MD Units is taken from the “Top‐Down”, as shown 
below. As with the Geogrid Extend Left/Right and Copy/Paste function, the new sections still must be 
Analyzed independently as they have not been verified yet.   

 

 

Item 74 – Dec 2021 

In the October 2021 release, an additional field was added to the Soil Conditions Tab called “Earth 
Surcharge”.  It was a minor addition and as such an explanation of it was not included in this document.  
For clarity, it allows the user to input a different Soil Unit weight for the Slope above the Wall than 



assuming it is the Infill Material.  This weight is used for Weight of Wall calculations.  If it is left blank, 
Vespa will default to using the Reinforced Unit Weight.   

Item 75 – AASHTO 2020 and 2015 (Dec 2021) 

In April 2020 (Item 60 above), after discussions with various State DOTs, it was determined that the 
empirical limit of 10 degrees for the Wall Batter (<10 degrees considered vertical) was at the discretion 
of the Designer.  Applying this limit resulted in a model that was inconsistent as the Wall Batter was 
used to accurate define the geometry of the structure (Weight of Wall, Moment Arms for Resisting 
Moments, etc), but was ignored for the calculation of Kab, Internal Failure Angle.  Vespa allowed the 
application of Omega consistently throughout the analysis.  However, we have just added an additional 
option of setting Omega to zero if the user decides to.  Refer to Settings/Options/Analysis/AASHTO.   

Item 76 – ICS Updates 

76.1 ‐ In Settings/Options/ICS the user can set the Factor of Safety for Static and Seismic.  The default is 
set at 1.3 for Static and 1.1 for Seismic (NCMA Defaults).  The field was not set up to allow the user to 
input a decimal (i.e. 1.5), and only allowed round numbers (i.e 2).  This has been rectified to allow 1 
decimal place. 

76.2 – When selecting multiple panels (Shift Key+Select) and running ICS, the results for all panels were 
not being saved as you moved from Tab to Tab (i.e. you would need to re‐run the analysis to see the 
results for each individual panel).   

76.3 – An option has been added in Settings/Options/ICS to allow the user to either include Block/Grid 
Connection in accordance with Figure 8‐6 (NCMA) or include only Block/Block Shear (with or without 
reinforcement at interface).   

76.4 – Full Output button has been added to ICS Screen.   

January 2022 

Item 77 – AASHTO Methodology.  ICS option had been turned off when running AASHTO. It has been 
turned back on.  

Feb 2022 

Item 78 – The Earth Surcharge (Soil Tab) input field that was added (to change the Unit weight of the 
Slope above the Wall) required the back‐end database to be updated to load older files.  This was done.  

Item 79 – NCMA Equation 7‐29 which calculates the reduced Geogrid Length used for Bearing Resistance 
calculations was updated to account for Wall Batter per the latest printing (5th) of the NCMA Manual. 

Item 80 – Updated Help File added.   

March 2022 

Item 81 – Multi‐Depth Auto‐Generate upgraded for more optimum solutions for Full Wall.   

November 2022 



Item 82 – NCMA, Seismic.  The Option to use the External Horizontal Acceleration Coefficient for Seismic 
Crest Toppling was reversed.  Therefore, if it was “on” the Internal would be used (more conservative) 
and “off” the External would be used.  This has been fixed, so “on” uses the External Coefficient and 
“off” uses Internal. 

 

Item 83 – No Fines Concrete (Gravity Wall) Update (NCMA / BS8006) Feb 2023 

When utilizing the No‐Fines Concrete, users have indicated that in some cases the Gravel Base is 
extended fully under the No‐Fines Backfill as shown below. 

 

In other cases, the Gravel Base is only under the Block (Facing) and the No‐Fines Concrete Backfill is 
bearing on the foundation (native) material.   



To accommodate this, a check box has been added to the Wall Unit Tab where the user can indicate 
which approach they are utilizing.  When checked ON, the Align to No Fines option extends the Gravel 
Base under the entire No Fines backfill zone (as shown above).  In this scenario, the Base Sliding 
resistance is calculated in the same way as a typical conventional wall where the Base Material Friction 
Angle is utilized along with the Masonry Friction Factor (µ).  It should be noted that for a smooth, 
manufactured masonry block, the µ value recommended by NCMA is 0.7 (Well graded gravel base).  As 
the No‐Fines Concrete is placed/poured directly on the gravel base, it is likely that the coefficient used 
could be higher.  When the option is OFF, it is treated more like a Reinforced Mass and the Foundation 
Soil friction angle is used, along with the option for Cohesion.   

 

 

Item 84 – AASHTO 2020 Conventional (minor update).  

To account for Live and Dead load offsets, a factor is calculated that reduces the applied load as a 
function of the offset distance (Qlfactor and Qdfactor).  This conservative factor is based on a 1H:1V line 
of influence.  The equation compared the Load Offset to the wall Height (H).  To better accommodate 
the effect of a broken back slope, the equation now compares the Load offset to the wall Height (H) + 
the slope height (hs).   

Item 85 – British Standard 

The British Standard now includes the No‐Fines Analysis.  Also, Creep and Durability reduction factors to 
the Connection. 

Item 86 – AU Standard 

Minor modifications to Fg(n) calculation.   

Item 87 – Standard Soil Parameters 

For the Unit Weight of Gap‐Graded Gravels (GP), Vespa currently uses 125 pcf (19.6 kN/m^3).  The range 
typically found in available tables/resources varies between 110‐130 pcf, however, some users have 
noted that it is typically closer to 115 pcf. As such, we will adjust the default to 115.   



Also, the friction angle provided for GW Gravel is currently 39 degrees.  While this is often the case, 
some users note that Geotechnical Reports may not allow this high of a Friction Angle without testing. 
As such, we have adjusted it down to 37 degrees.   

Note that these values (Unit Weight and Friction Angle), are just a starting point based on some typical 
known values.  The user must modify these values based on available information and have them 
verified by the Site Geotechnical Engineer.   

Item 88 – Alternate Seismic Method – NCMA (Update to Existing Feature) 

Section 9.2 of the NCMA Design Manual, 3rd Edition, states that the calculation of the horizontal seismic 
coefficient is restricted to conditions where kh < (tan (φ‐β).  When conditions are such that this 
restriction is exceeded, Vespa provides two options.  In the Settings/Options/Analysis/NCMA, there is an 
option to turn ON/OFF the Alternate Seismic Method.  If this is OFF, Vespa runs the Seismic Analysis by 
simply setting the term φ‐ atan(kh) ‐β = 0, with the warning shown below.  This approach appears to be 
consistent with the NCMA Software, although not technically correct.   

 

If the Alternate Seismic Method option is ON in the Settings, then for External Stability a Trial Wedge 
Method of Analysis is run.  This method must have a Crest Offset defined.  In this update, we have 
added the ability for the user to specify the Trial Wedge Angle at the back of the Reinforced Zone to 
start the analysis process.   

For Internal Stability, the Alternate Seismic Method applies the approach outlined in NHI‐10‐024 which 
calculates the weight of the Active Wedge, then calculates the dynamic inertial force, Pi.  The update to 
this version allows for displacement effects to reduce the kh(int) in the same way that it reduces kh(ext), 
which is Ao x 0.5.   

 

 

 


